## Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚨</td>
<td>Caution</td>
</tr>
<tr>
<td>📝</td>
<td>Example</td>
</tr>
<tr>
<td>⚡</td>
<td>Note</td>
</tr>
<tr>
<td>🔪</td>
<td>Recommendation</td>
</tr>
<tr>
<td>☑</td>
<td>Syntax</td>
</tr>
</tbody>
</table>
Contents

Assembly-to-order (LO-ASM) ........................................................................................................5
LO Assembly Processing ................................................................................................................. 6
Assembly-to-order: Concept and Settings ..................................................................................... 7
Assembly-to-order .......................................................................................................................... 8
  Assemble-to-order with Production Orders .............................................................................. 11
  Assemble-to-order with Planned Orders .................................................................................. 13
  Assemble-to-order with Projects .............................................................................................. 15
  Assemble-to-order with Variant Configuration ......................................................................... 16
Settings for Assembly-to-order ..................................................................................................... 18
  Special Settings for Production Orders ................................................................................... 20
  Special Settings for Planned Orders .......................................................................................... 21
  Special Settings for Repetitive Manufacturing ........................................................................ 22
    Production Cost Collector ....................................................................................................... 24
  Special Settings for Projects ..................................................................................................... 25
  Special Setting for Variant Configuration .................................................................................. 27
Planning Strategies ....................................................................................................................... 28
Make-to-Order Using Assembly Processing .................................................................................. 30
Make-to-Order Using Assembly Processing .................................................................................. 31
Creating an Assembly Order ....................................................................................................... 32
Creating a Project/Network in Assembly Processing .................................................................. 34
Creating an Assembly Order for a Configurable Material ............................................................ 37
Scheduling in Assembly Processing ............................................................................................. 39
Availability Check in Assembly Processing .................................................................................. 42
Availability Check According to ATP Logic .................................................................................. 43
Missing Parts List (Availability Check: Overview) ......................................................................... 44
Missing Parts Overview ................................................................................................................ 47
Availability Check Against Planned Independent Requirements ................................................. 49
Navigating in the Sales Order in Assembly Processing ................................................................. 51
How Changes Affect Assembly Processing .................................................................................. 52
Pricing in the Assembly Order ...................................................................................................... 53
Shipping in Assembly Processing ............................................................................................... 55
Billing in Assembly Processing .................................................................................................... 56
Collecting Costs in Assembly Processing .................................................................................... 57
Sample Scenario: Assembly Processing Using a Production Order ............................................. 58
Make-to-Order Without Assembly Processing ............................................................................... 59
Production Planning and Control for Assembly Processing .......................................................... 60
Production Planning and Control for Production Orders ............................................................... 61
Production Planning and Control for Repetitive Manufacturing ................................................. 62
Production Planning and Control for Networks and Projects ...................................................... 65
Assembly-to-order (LO-ASM)
LO Assembly Processing

Assembly Processing: Concept and Settings [Page 7]
Make-to-Order Using Assembly Processing [Page 30]
Production Planning and Control for Assembly Processing [Page 60]
Assemble-to-order: Concept and Settings

Assembly Processing [Page 8]
Special Settings for Projects [Page 25]
Assembly Processing With Planned Orders [Page 13]
Special Settings for Repetitive Manufacturing [Page 22]
Planning Strategies [Page 28]
Assembly Processing With Projects [Page 15]
Assembly Processing With Variant Configuration [Page 16]
Settings for Assembly Processing [Page 18]
Special Settings for Production Orders [Page 20]
Assemble-to-order

An assemble-to-order environment is one in which the product or service is assembled on receipt of the sales order. Key components are planned or stocked in anticipation of the sales order. Receipt of the order initiates assembly of the customized product. Assemble-to-order is useful where a large number of finished products can be assembled from common components. In the R/3 System, assemble-to-order is a special kind of make-to-order planning strategy; you define planning strategies in Customizing.

If you use an assemble-to-order strategy, you can check material and resource availability at the moment when the sales order is created. You can quote your customers reliable delivery dates because you know whether the desired quantity will be available on the desired date. If the complete quantity cannot be committed, the system tells you when the total quantity will be available and whether you can commit a partial quantity.

As the finished product is not usually kept in stock, an availability check is carried out at component level when the sales order, quotation, or inquiry is created. The results of the availability check are as follows:

- The committed order quantity of the sales order is based on the component with the smallest available quantity.
- The confirmed delivery date of the sales order is based on the availability date of the component that will be available last.

Another important factor for ensuring that customers are provided with reliable due dates is continuous feedback between sales and production. In the R/3 System, changes to quantities or dates for production or procurement of components are passed back to the sales order of the finished product where the committed quantity or confirmation date is also changed. Similarly, changes to quantities or dates in the sales order are passed on to production and/or procurement.

Assemble-to-order: Process Flow

When you create a sales order, a customer quotation, or an inquiry with one of the assemble-to-order planning strategies, the system automatically creates an assembly order. An assembly order is one of the following procurement elements:

- Planned order
- Production order
- Process order
- Network (project)
- Service order

The choice of procurement element is determined by the strategy group in the material master record.

The system carries out scheduling for the assembly order. You can also have the system carry out capacity checking when the sales order is created. Furthermore, the bill of material is exploded for the assembly order to determine the required components. The availability of each component is then checked. This check can be carried out either according to ATP logic or against planned independent requirements at assembly level. It determines what quantity can be committed on the desired delivery date. If no quantity can be committed, the system displays the
missing parts. If you carry out the check using ATP logic, the system also determines dates for partial and final confirmation.

If a material is configured in the sales order, the results of configuration are copied to the assembly order. The system then checks the availability of the components that were selected on the basis of configuration.

If the assembly order is a planned order, any changes made to the sales order become immediately effective in the planning order. If the assembly order is a production order or a network, changes made to the sales order become effective in the production order or network on condition that its status allows this.

By default, changes to the assembly order automatically adjust the committed quantities and dates in the sales order. However, you can also configure the system so that changes made to the assembly order do not affect the sales order.

**Procedures for Assemble-to-order**

- 1:1; that is, exactly one procurement element exists for each sales order item. This is known as the static procedure.

- A loose link exists between sales order items and procurement elements; you can split quantities and dates both in the sales orders and in production. This is known as the dynamic procedure.

Static assemble-to-order is represented in the following diagram:
Assembly-to-order (LO-ASM)

Assemble-to-order

Create sales order (with assemble-to-order)

- Strategy group from material master record
- Enter requirements type manually for sales item order

Assembly type and order type (if assembletype 2 or 3)

- Planned order
- Production order
- Process order
- Network (project)
- Service order

Backward scheduling: Can the desired delivery date be met?

Yes

- ATP check according to order type
  - Confirmed date is desired delivery date

No

- Scheduling today
  - New confirmation date determined as result of scheduling

Desired delivery date becomes order start state or order finish date in service order

Sales order is saved with planned order, production order, process order, network, or service order
Assemble-to-order with Production Orders

Assemble-to-order with production orders is particularly useful if you:

- Require **status management** functionality
  
  You can use status management, for example, to
  
  - Document the current processing status of an object
  - Allow or forbid certain business transactions
  - Group or select objects by status (for example all orders with the status released, or all components with the status missing part)
  - Trigger rework functions automatically (using trigger points)

- Want to carry out business functions at **operation level**, such as:
  
  - Releasing operations
  - Printing shop papers
  - Entering completion confirmations

- Keep track of **costs** during the production process
  
  Every confirmation or goods movement carried out for the production order causes an update of the actual order costs.

- Want to use the **collective order** functionality
  
  A collective order is a structure that links production orders over several manufacturing levels. It offers the following advantages:
  
  - Any changes to dates or quantities have an immediate effect on any dependent orders within the collective order.
  - No goods movements are required for sub-assemblies
  - You can carry out an availability check across all production levels
  - Each production order is automatically settled to the superior production order. The top production order is then automatically settled to the sales order.

  Collective orders are especially suited to the following types of production:

  - Continuous flow production
  - Production using parallel production lines
  - Make-to-order production

- Want to use the **rework** functionality
  
  You can use rework functionality in order to compensate for malfunctions or errors that occur during the production process.

  With **unplanned** malfunctions/errors, you can
  
  - Insert rework operations
  - Insert reference operation sets
Assemble-to-order with Production Orders

- Create rework orders
  With planned malfunctions/errors, you can
- control rework by using trigger points

- Produce co-products
  Only if you set up assemble-to-order with production orders can you use co-products.

Production Order Created Directly or via a Planned Order

When creating a sales order, you do one of the following:

- Create a production order directly
  Here, you can make immediate use of all the production order functionality (such as the status maintenance).

- Create a planned order first which is converted into a production order at a later date. In this case, you can also implement planning decisions (such as external procurement or in-house production) later on in the assembly process.

In assemble-to-order, you can only convert planned orders into production orders if you use a strategy group or requirements class with a dynamic assembly type. For more information, see Assembly Processing With Planned Orders [Page 13] and Assembly Processing With Projects [Page 15].
Assemble-to-order with Planned Orders

Assemble-to-order with planned orders is particularly useful:

- If production control is managed using production orders (see Special Settings for Projects [Page 25]) but you do not want to create the production order along with the sales order. You can use the planned order to fine-tune planning and then convert it into a production order at a later date.

- If production is controlled using Repetitive Manufacturing. The planned order is then the run schedule quantity which you can plan using the planning and control tools provided by Repetitive Manufacturing. In this procedure, the goods receipt for the material can also be posted with reference to the sales order number. Thus, the costs can also be directly assigned to the sales order even in Repetitive Manufacturing.

Assemble-to-order with Repetitive Manufacturing

Use assemble-to-order with Repetitive Manufacturing if several of the following points apply to your situation:

- Production of the finished product is carried out in clear and simple steps.
- The assembly is produced in a constant flow over the production lines.
- Simple routings are used, or assembly can be carried out without routings.
- The components can be staged anonymously at the production lines. The components are procured, for example, with KANBAN using consumption-based planning, or with the planning strategy "subassembly planning".
- You want to reduce the effort required for production control and backflushing.

Sample Scenario for Assemble-to-order with Repetitive Manufacturing

- The production process is kept as simple as possible. There are only a limited number of production levels involved in producing the product. The number of components is relatively low, however, it is quite possible to produce a large number of finished products due to configuration options.

- The components required for final assembly are selected via the configuration in the sales order and are staged at the production line anonymously. You can use the assembly order to carry out an availability check for the selected components. Components that are always readily available are excluded from the availability check by setting the appropriate indicator in the material master record.

- The finished product is assembled without a routing and the operations are similar. The planning table in Repetitive Manufacturing provides the planner with an overview of the production rates. Here, the planner can also check capacities for the production lines and distribute the ordered quantities to the production lines with available capacity.

- When production is complete, the goods receipt for the finished product is posted with reference to the sales order number - a special function exists in Repetitive Manufacturing for this. Once the goods receipt is posted, the goods are withdrawn for the specific sales order and the assembly order is deleted.

- For the scenario described above, you can also work without using the planning functions of Repetitive Manufacturing. In this case, capacity planning is not carried out
Assemble-to-order with Planned Orders

from the planning table in Repetitive Manufacturing, but instead, using the capacity leveling functions in capacity planning. However, you can still use the backflushing functions in Repetitive Manufacturing.

For more information on Repetitive Manufacturing, see *PP Repetitive Manufacturing*. 
Assemble-to-order with Projects

Use networks and projects for assemble-to-order if you manufacture or engineer your products to order and you are not sure exactly how you are going to execute the sales order:

- If your customer orders a product whose manufacturing or assembly process is so complex that you consider it a project. With networks, you can plan in the mid- to long-term, for example, when the actual assembly process does not start for another 6 months.

- If your customer orders a customized or configured product that you are manufacturing or assembling for the first time. With a network, you have a flexible framework for rough-cut planning when you enter the sales order that you can add more detail to, and, if necessary, create production orders.

- If your manufacturing or assembly process is characterized by technical or time interdependencies, such as, one activity cannot finish until the preceding activity has finished.

- If you want to use the unique functionality of the Project System to carry out your projects, for example, you can create a work breakdown structure (WBS) for a project at the same time that you create a sales order.

You can still use planned orders and production orders if you choose to create a network from a sales order.

Account Assignment

In assemble-to-order with projects you can choose where the costs are collected: for example, in a work breakdown structure element (WBS element), in the sales order, or in the network.

<table>
<thead>
<tr>
<th>Network is...</th>
<th>Account assignment is made to...</th>
<th>The standard WBS element from the standard network header...</th>
</tr>
</thead>
<tbody>
<tr>
<td>header-assigned</td>
<td>sales order</td>
<td>is not copied into the network header</td>
</tr>
<tr>
<td>activity-assigned</td>
<td>project</td>
<td>is copied into the network header as a WBS element. If no standard WBS element has been entered in the standard network header, you have to specify a WBS element when you save.</td>
</tr>
<tr>
<td>header-assigned</td>
<td>project</td>
<td>is copied into the network header as a WBS element. If no standard WBS element has been entered in the standard network header, you have to specify a WBS element when you save.</td>
</tr>
</tbody>
</table>

It is not possible to assign an network with activity account assignment to a sales order.
Assemble-to-order with Variant Configuration

You can also use assemble-to-order for configurable products. Here, the availability check can be carried out at component level only.

Configuration is carried out as usual. Depending on the selection of the strategy group in the material master record of the configurable material, a planned order, production order, or network can be created parallel to the sales order. The characteristic values assigned to the configurable material are passed on to the planned order, production order, or network. The BOM components and operations or activities you require are selected on the basis of these characteristic values.

The components selected as a result of the characteristic values are included in the availability check for assembly order processing. Any of these components that are in stock are reserved immediately.

However, only the components on the top level of the BOM are included in the availability check. Problems occur if the BOM contains other configurable materials. Configurable materials are not kept in stock, so they are not included in the availability check. The components of these subordinate configurable materials are not checked for availability either because the availability check is restricted to the top level of the BOM.

You have the following options for checking the availability of components of subordinate configurable materials:

- You can define the configurable assembly as a phantom assembly. Phantom assemblies are not manufactured - the components are used directly in the finished product.
  
  To define a configurable assembly as a phantom assembly, enter the special procurement key 50 on the MRP 1 screen of the material master record. However, this means that you cannot create a production order for this specific assembly.

- You can use the collective order functionality in shop floor control. Collective orders allow you to link planned orders or production orders across several manufacturing levels. For more information on collective orders, see the SAP documentation PP Production Orders Guide.

If you select assembly order processing with a network, the procedure for configuring the material depends on whether the material and the standard network are allocated to the same class or to different classes.

- Usually, the material and the standard network are allocated to the same class. Characteristic values assigned in the sales order are directly passed on to the Project System, and a network is created.

- If the material and the standard network are allocated to different classes, you assign characteristic values separately for the material and the standard network.

  When a network is created, you must configure the standard network separately if the system recognizes that the material and the standard network are allocated to different classes.

If you are using assembly order processing with a network and you make subsequent changes to the configuration of the material in the sales order, the existing network is deleted and a new network is created. This is only possible if the activities in the network have not yet been processed. You cannot change the configuration of the material in the sales order once processing of the activities in the network has started.
Any manual changes to a network are overwritten when a new network is created.
Settings for Assemble-to-order

Setting the Planning Strategy for Assemble-to-order

If you want to use assemble-to-order, you must select a planning strategy that allows it. In the standard R/3 System, separate planning strategies or strategy groups and requirements classes are supplied for each of the three procurement elements (production order, planned order, network), and each one contains all the necessary settings, such as the assembly type or the order type for the production order. For more information on planning strategies, strategy groups and requirements classes, see Planning Strategies [Page 28].

The strategy group is assigned to the material in the material master record.

Changes to the settings for assemble-to-order are made in the appropriate requirements classes in Customizing for Sales and Distribution (in the step Define requirements classes). The following parameters are relevant for assemble-to-order:

- **Assembly type**
  
  The assembly type (indicator A) determines,
  
  - which procurement element is created
  
  - whether a 1:1 link exists between the sales order and the procurement element (static procedure) or whether a loose link exists with the option of splitting dates and quantities (dynamic procedure).

- **Order type**

  You have to enter the order type for production orders, process orders, networks/projects (not for planned orders). For more information here, please refer to the sections entitled, Assemble-to-order with Variant Configuration [Page 16] and Special Settings for Production Orders [Page 20].

- **Availability check at component level**

  You use the indicator CA (Component availability check) to set whether the availability check is to be carried out at component level when creating the assembly order. If you do not make this setting, the availability check is only carried out for the finished product.

- **Type of component availability check**

  With the indicator Av (SD availability check), you determine whether the component check is to be carried out according to ATP logic or as a check against planned independent requirements. If you want to carry out the check against planned independent requirements, there are also other settings to be made. For more information here, please refer to the section entitled, Availability Check in Assemble-to-order [Page 42].

- **Displaying missing parts overview**

  You use the indicator Dia (Dialog assembly), to determine whether the system is to display a list of missing parts with information on calculated quantities and dates, that is, the components that are not fully available. You can also use this indicator to control whether the quantities and dates of the selected components can be processed interactively in the sales order.

- **Checking scheduling and capacity data**
You use the indicator Cap (Capacity available) to determine whether the system is to carry out lead time scheduling for the procurement element when creating the sales order or whether capacity planning is to be carried out for the procurement element when creating the sales order.

- **Updating the sales order when changing the procurement element**
  
  You use the indicator No update to determine whether changes to the procurement element are to be passed on to the sales order, that is, whether the changes to the procurement element influence the committed quantities or dates in the sales order.

If you want to make other settings (for example, if you want to select the assembly type for dynamic processing), proceed as follows:

1. Copy the existing requirements class to a new requirements class and change the appropriate entries (Customizing).
2. Create a new requirements type and assign the new requirements class to it.
3. Create a new strategy and assign the new requirements type to it.
4. Create a new strategy group and assign the new strategy to it.

**Settings for Components**

If you want to carry out the availability check at component level, you must maintain the following indicators for every component to be checked in the material master record:

- The availability check must be allowed and switched on. To do this, enter the appropriate checking group in the field entitled, Availability check (MRP 2 screen). Here, you can also switch off the availability check for low-value or uncritical components.
- The indicator Indiv./collective (MRP 2 screen) must be set to Collective requirements. Otherwise, the system automatically creates a separate stock segment for each component if the requirement quantities of the higher-level assembly are also to be planned individually.

Over and above these general settings, you can also make several specific settings per procurement element.

For more information on the special settings of each procurement element, see:

- Special Settings for Production Orders [Page 20]
- Special Settings for Planned Orders [Page 21]
- Special Settings for Repetitive Manufacturing [Page 22]
- Special Settings for Projects [Page 25]
- Special Setting for Variant Configuration [Page 27]
Special Settings for Production Orders

All Customizing settings that you require for assembly processing with production orders, such as strategy group, requirements class and order type are already predefined by SAP in the Standard System.

Strategy Groups

The following strategy group is predefined for production orders:

- Strategy group 82: assembly processing with production orders

  Here, the static procedure (that is, the 1:1 link between production order and sales order) is preset as the assembly type.

Requirements Type and Requirements Class

Strategy group 82 refers to the following requirements type or requirements class in the Standard System.

- requirements type KMFA
- requirements class 201

Order Type

The following order type for production orders is predefined in the requirements type 201:

- Order type PP04: Production order with assembly processing

  If, for some reason, you want to use an order type that is different to the one predefined by SAP, you must make sure that the following scheduling parameters are set for the order type:

  - Key ‘Backward scheduling’
  - Indicator ‘Adjust basic dates’

If you use all the standard system settings, you do not need to make any additional settings in Customizing:

Bills of Material

For assembly processing with production orders, the finished product must have a valid bill of material.
Special Settings for Planned Orders

All the settings in Customizing you require for assembly processing with planned orders are already predefined by SAP. These settings include, for example, the strategy group and the requirements class. The settings in the system standard allow the planned order to be converted into a production order and in Repetitive Manufacturing it can be used as a run schedule quantity.

Strategy Group

The following strategy group is predefined for planned orders:

- Strategy group 81: assembly processing with planned orders
  Here, the dynamic procedure (that is, the loose link between planned order and sales order) is preset as the assembly type.

Requirements Type and Requirements Class

Strategy group 81 refers to the following requirements type or requirements class in the Standard System:

- requirements type KMSE
- requirements class 200
Special Settings for Repetitive Manufacturing

For assembly processing with Repetitive Manufacturing, the same strategy group and requirements type/class are used as described in section Special Settings for Planned Orders [Page 21].

If you use the planning table in Repetitive Manufacturing, there are more settings you have to make.

Repetitive Manufacturing for Make-to-Order Production With or Without the Planning Table

The special settings for Repetitive Manufacturing depend on the following criteria:

- whether you want to use the planning table in Repetitive Manufacturing to assign the production quantities to production lines or to carry out capacity planning, for example
- whether you do not want to use the planning table to plan the run schedule quantities and instead, for example, you want to use:
  - the current stock/requirements list from MRP to gain an overview of the run schedule quantities
  - the capacity leveling functions from the stock/requirements list or from capacity planning to adjust the master plan.

Repetitive Manufacturing for Make-to-Order Production with Planning Table

If you want to use the planning table, you must maintain the following data:

- In the material master record:
  - You must allow Repetitive Manufacturing for the material.
  - You must enter a Repetitive Manufacturing profile. Various control parameters are contained in this profile, for example, for the movement types in backflushing and for posting costs.

We recommend that you use a profile for which the cost collector has to be created manually as a cost collector is not required for make-to-order production.

The Repetitive Manufacturing profile also determines whether the costs are to be posted with or without activities (machine costs, labor costs, and so on) when backflushing. If you decide to post with activities, they are then automatically posted with the final backflush.

- You must create a production version containing the data relevant for production - alternative BOM, group, group counter, production line, and so on. If you work without routings, you must enter at least the BOM and the production line in the production version.

- In the Repetitive Manufacturing menu:
  - You must create a run schedule header with reference to the production version.

Repetitive Manufacturing for Make-to-Order Without the Planning Table

If you choose not to work with the planning table, you must make the following settings in the material master record:
You must enter a Repetitive Manufacturing profile. Various control parameters are contained in this profile, for example, for the movement types in backflushing and for posting costs.

We recommend that you use a profile for which the cost collector has to be created manually as a cost collector is not required for make-to-order production.

The Repetitive Manufacturing profile also determines whether the costs are to be posted with or without activities (machine costs, labor costs, and so on) during backflush. If you decide to post with activities, they are then automatically posted with the final backflush.

The special goods receipt posting with reference to the sales order is available whether you work with or without the planning table.
Production Cost Collector

The costs of producing a material are grouped together and settled using a production cost collector. This is the usual method for determining and settling costs in Repetitive Manufacturing without make-to-order production.
Special Settings for Projects

SAP has predefined all the settings in Customizing you need to use networks in assembly processing: strategy group, requirements class, network type and condition type. If you use the standard settings, you do not have to make any additional settings in Customizing. However, you will have to make settings for your materials and standard networks.

Strategy Groups

SAP has predefined the following strategy groups for networks and projects:

- **83**: Assembly processing with networks with requirements class 202
- **85**: Assembly processing with network/project with requirements class 212

If you do not assign an appropriate MRP controller or strategy group to your material, you will not be able to create a network from a sales order.

See also:

For more information on strategy groups, refer to the section entitled Planning Strategies [Page 28].

Requirements Classes

SAP has predefined the following requirements class for networks:

- **202**: A network with network type PS05 (header account assignment) and account assignment category E (assignment to the sales order).
- **212**: A network with network type PS04 (activity account assignment) and account assignment category D (assignment to project or WBS element).

See also:

For more information on requirements classes, refer to implementation guide Production under Requirement types/requirement classes.

Network Types

SAP has predefined the following network types:

- **PS04 and PS05**: Networks with scheduling type backwards, where the scheduled dates are calculated automatically and the basic dates are adjusted automatically. When you set the indicator for the basic dates, the system updates the network basic dates with the scheduled dates and then writes them into the sales order as confirmed dates.

See also:

For more information on network types, refer to the SAP documentation PS - Project System.
Special Settings for Projects

Prerequisites for Networks
To be able create a network from a sales order you need:

A Material Master Record
The data in the material master for the product controls whether a network is created. The strategy group in the material master controls whether a network can be created from a sales order. The requirements class assigned to the strategy contains all the important information for this, such as assembly type, network type, configuration, account assignment category.

See also:
For more information on creating a material in the material master, refer to the SAP documentation LO - Managing Material Master Data

A Standard Network for Production or Assembly
The network that is created in the background from a sales order is always copied from the standard network to which the material in the sales order is allocated. You can also assign the standard network to a standard WBS element so that the sales order can be settled to a project, for example.

See also:
For more information on creating a standard network, refer to the SAP documentation PS - Project System

Network Settings
In the standard network, you can make the link between the material, the network to be created for assembly processing, and the account assignment. Every time you create a sales order for the material you entered here, the system will automatically copy this standard network to create the network. If you do not enter any data here, you must enter the required data online every time you create a sales order for assembly processing.

You make the settings from the Basic data menu, by selecting the menu options Standard structures → Alloc mat → std.ntwk.
The Network Parameters - From Sales Order screen is displayed.

On the detail screen you allocate a material to a standard network as well as to a standard WBS element for account assignment.
Special Setting for Variant Configuration

You can use each of the available procurement elements to carry out assemble-to-order with variant configuration. To do so, you must set variant configuration to *Obligatory* for each of the strategy groups or planning strategies in the assigned requirements class.
Planning Strategies

The planning strategies represent the business procedures for planning and producing a material.

In the system, the planning strategies are recorded in Customizing by a combination of requirements types from Demand Management and from Sales Order Management. This combination of requirements types determines the consumption of planned independent requirements by customer requirements, or how the availability check is to be carried out.

The planning strategies are maintained in Customizing for Demand Management. Here, the requirements types are combined for the planning strategy. Technically speaking, the requirements types are texts that represent the planning strategy in the application (Demand Management, Sales and Distribution). The requirements type is controlled by another key - the requirements class. The requirements class contains all the control parameters required for Demand Management and Sales and Distribution. To maintain the planning strategy, you only have to combine the necessary requirements types and the corresponding requirements class is assigned automatically along with all the accompanying control parameters.

SAP recommends that you work with the planning strategies delivered in the standard system. However, if you want to change the texts of the planning strategies, you can do so via the requirements type.

By assigning a planning strategy to a particular material, the system determines the correct requirements type (and thus all the control parameters of the requirements class) when creating planned independent requirements or sales orders. Here, you must maintain the following objects and assignments:

- You must maintain the **planning strategy** (in Customizing for Demand Management). The planning strategy is defined either by a requirements type from Demand Management or by a requirements type from sales order management or by a logical combination of both requirements types. This determines, for example, how the consumption of planned independent requirements by customer requirements is carried out and whether the availability check according to the ATP logic is carried out.

- You must assign the planning strategy to a **strategy group** (in Customizing for Demand Management) so that a material can be planned with various planning strategies. You can maintain one main strategy and up to six alternative strategies.

- You must **assign the strategy group to the material** (in the material master record), so that the system can determine the correct requirements type automatically.

The following graphic illustrates how the individual objects fit together:
You can also assign the planning strategy via the MRP group. You do this by assigning the strategy group in Customizing for Demand Management to the MRP group. In this case, the MRP group is assigned to the material in the material master record.

If you have entered a strategy group or an MRP group containing the appropriate strategies in the material master record, you then do not have to enter a requirements type in Demand Management. The system determines the valid requirements type via the strategy group from the material master record and proposes this type automatically when creating independent requirements (or customer requirements). If the strategy group contains more than one planning strategy, the system proposes the requirements type of the main strategy. If necessary, you can overwrite this proposal using one of the requirements types from the alternative strategies.
Make-to-Order Using Assembly Processing

In this section, you will learn about the functions of assembly processing in the sales order:

- Make-to-Order Using Assembly Processing [Page 31]
- Creating an Assembly Order [Page 32]
- Creating a Project/Network in Assembly Processing [Page 34]
- Creating an Assembly Order for a Configurable Material [Page 37]
- Scheduling in Assembly Processing [Page 39]
- Availability Check in Assembly Processing [Page 42]
- Navigating in the Sales Order in Assembly Processing [Page 51]
- How Changes Affect Assembly Processing [Page 52]
- Pricing in the Assembly Order [Page 53]
- Shipping in Assembly Processing [Page 55]
- Billing in Assembly Processing [Page 56]
- Collecting Costs in Assembly Processing [Page 57]
- Sample Scenario: Assembly Processing Using a Production Order [Page 58]
- Make-to-Order Without Assembly Processing [Page 59]
Make-to-Order Using Assembly Processing

When you create a sales order for a material which has been assigned a strategy group for assembly processing, an assembly order is created automatically in the background and assembly processing is initiated. The assembly order is a generic term used to group the documents used in assembly processing. Depending on the strategy group of the material for which you are creating the sales order, the following assembly orders can be created:

- production order
- planned order
- network

In assembly processing, you can make use of the functionality of both the sales order and the corresponding procurement element. For example, both the sales order and the assembly order are scheduled in one run during sales order entry. This provides you with precise delivery dates and quantities at this early stage. As the sales order and the assembly order are directly linked to one other, any subsequent changes you make to dates and quantities in one of the documents are reflected automatically in the other.

An assembly order is only created if the schedule line category in the sales order is defined to pass on requirements. Thus, you can activate and deactivate the function which creates an assembly order in the schedule line category.

💡 You can also perform assembly processing with pre-sales documents (inquiries and quotations). Should you not wish an assembly order to be created at the pre-sales stage, adjust the order probability in the pre-sales document to 0% or use a schedule line category which is not set up for transfer of requirements and does not, therefore, initiate the creation of an assembly order.
Creating an Assembly Order

To create an assembly order, proceed as follows:

1. Select Logistics → Sales/distribution → Sales on the main menu screen.
2. Select Order → Create.
3. Enter the order type. This is usually TA (standard order) in the standard system.
4. If necessary, enter the organizational data.
   The values for sales organization, for distribution channel and the division are usually proposed from user-defined parameters. Entries for the sales office and the sales group are optional.
5. Press Enter.
6. Enter the following data:
   – Customer number of the sold-to party
   – Customer’s purchase order number
   – Material number
   – Order quantity for the material
7. Press Enter.
   The system performs an availability check for the components required for assembly and creates an assembly order in the background. Scheduling is performed for both the sales order and the assembly order.

   📘 For more information on scheduling in assembly processing, see Scheduling in Assembly Processing [Page 39].

   For more information on the availability check, please refer to the section entitled Availability Check in Assembly Processing [Page 42].

   After the availability check is performed, the system either displays the availability control screen or, if the system determines that any of the components are not available, it issues a list of these missing parts.
8. If the system displays the missing parts list, select Back to reach the availability control screen.
9. Accept either the one-time delivery or the delivery proposal.
   The system returns you to the overview screen in the sales order.

   📘 You can access the assembly order from the sales order. For information on how to do this, see Navigating in the Sales Order in Assembly Processing [Page 51].
10. Save your document.
Creating an Assembly Order

The system saves the sales order and the assembly order that was created in the background.
Creating a Project/Network in Assembly Processing

To create a network from a sales order, follow the procedure described in section Creating an Assembly Order [Page 32]. When you save the sales document, the system creates an operative network in the background and assigns it a number.

You can create a network for each item in your sales order. If these networks have interdependencies, you can link the dependent activities together with relationships to form an overall network. Alternatively, if the quantity of the sales order item is greater than one, you can group assembly or other activities together into one network. For information on how the system calculates the work, duration, costs or material component quantities in this case, refer to Activities in PS - Project System.

If you have linked a standard network to a standard work breakdown structure and then save the sales document, the system creates an operative project, that is, an operative WBS and an operative network, in the background and assigns them numbers.

How is the Project Identifier Determined?

To easily match-up a customer project with the corresponding sales document, it is helpful when the project number contains the identifying number of the sales document.

How the system determines the project identifier from the ten-character sales document number, depends on whether you specified project number editing in Customizing of the Project System. Regardless of whether the project identifier is edited or not, the WBS element identifier must be unique. The system uses a search and replace technique which takes the first WBS element at level one and uses its identifying string as the basis for creating the identifier of all other WBS elements in the new project.

To ensure a one-to-one correspondence between the project and its related sales document, the identifying string of the standard WBS element should always be longer than ten characters.

SAP recommends that you use project number editing for projects created using assembly processing.

With project editing

The area between the first and the second special character of the identifier of the standard WBS is replaced by the corresponding number of positions from the sales document number starting from the right side of the sales document number. Therefore, to ensure a correspondence between the project and sales document, the area between the first and second special character of the identifier should always be at least ten characters long.

<table>
<thead>
<tr>
<th>Std. Proj. def. / WBS element</th>
<th>Sales document number</th>
<th>New identifier in operative project</th>
</tr>
</thead>
<tbody>
<tr>
<td>M/12345-001</td>
<td>0066778899</td>
<td>M/78899-001</td>
</tr>
<tr>
<td>M/123456789-001</td>
<td>0066778899</td>
<td>M/066778899-001</td>
</tr>
</tbody>
</table>
Without project editing

Project identifier is less than ten characters long

When the sales document number is longer than the project identifier, the system replaces the entire standard WBS identifier with part of the sales document number, starting from the right of the sales document number. The length of the standard WBS identifier remains the same.

<table>
<thead>
<tr>
<th>Std. proj. def.</th>
<th>Sales document number</th>
<th>New identifier in operative project</th>
</tr>
</thead>
<tbody>
<tr>
<td>M123456789</td>
<td>0066778899</td>
<td>0066778899</td>
</tr>
<tr>
<td>M12345</td>
<td>0066778899</td>
<td>778899</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Std. WBS element</th>
<th>Sales document number</th>
<th>New identifier in operative project</th>
</tr>
</thead>
<tbody>
<tr>
<td>M12345 (at level one)</td>
<td>0066778899</td>
<td>778899</td>
</tr>
<tr>
<td>M12345-1 (at level two)</td>
<td>0066778899</td>
<td>778899-1</td>
</tr>
</tbody>
</table>

Project identifier is more than ten characters long

- Project definition
  When the sales document number is shorter than the project identifier, the system replaces the first ten positions of project definition with the sales document number. Any remaining characters from the original project definition number are tacked on to the end of the new project identifier.

<table>
<thead>
<tr>
<th>Std. project def.</th>
<th>Sales document number</th>
<th>New operative project definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>M123456789ABC-1</td>
<td>0066778899</td>
<td>0066778899ABC-1</td>
</tr>
</tbody>
</table>

- WBS element
  When the sales document number is shorter than the project identifier, the system replaces the entire identifier of the first WBS element with the entire sales document number and truncates any extra characters. Subsequent WBS elements retain the additional identifying characters, as shown in the example below:
In this example, the system cannot create a new operative identifier for the standard WBS element M123456789ABC-2 because it is looking to replace the string M123456789ABC-1 from the first WBS element at level one. First you get the message that the WBS element already exists, then you must manually assign the WBS element a new identifier.

**See also:**

For more information on projects and networks, refer to the SAP documentation *PS - Project System*.
Creating an Assembly Order for a Configurable Material

To create an assembly order for a configurable material, proceed as follows:

1. Select Logistics → Sales/distribution → Sales on the main menu screen.
2. Select Order → Create.
3. Enter the order type
   This is usually TA (standard order) in the standard system.
4. If necessary, enter the organizational data.
   The values for sales organization, for distribution channel and the division are usually proposed from user-defined parameters. Entries for the sales office and the sales group are optional.
5. Press Enter.
6. Enter the following data:
   – Customer number of the sold-to party
   – Customer’s purchase order number
   – Number of the configurable material
   – Order quantity for the material
7. Press Enter.
   You reach the configuration editor. There you can assign values to the characteristics of the configurable material.
8. Select Back
   The system performs an availability check for the components required for assembly and creates an assembly order in the background. Scheduling is performed for both the sales order and the assembly order.

For more information on scheduling in assembly processing, please refer to the section entitled Scheduling in Assembly Processing [Page 39].

For more information on the availability check, please refer to the section entitled Availability Check in Assembly Processing [Page 42].

After the availability check is performed, the system either displays the availability control screen or, if the system determines that any of the components are not available, it issues a list of these missing parts.

9. If the system displays the missing parts list, select Back to reach the availability control screen.
10. Accept either the one-time delivery or the delivery proposal.
    The system returns you to the overview screen in the sales order.
Creating an Assembly Order for a Configurable Material

You can access the assembly order from the sales order. For information on how to do this, see Navigating in the Sales Order in Assembly Processing [Page 51].

11. Save your document.

The system saves the sales order and the assembly order that was created in the background.

See also:

Assembly Processing With Variant Configuration [Page 16]
Scheduling in Assembly Processing

Delivery Scheduling in the Sales Order
The system schedules the sales order using delivery scheduling. On the basis of the customer requested delivery date, the system performs backwards delivery scheduling to calculate the date on which shipping activities must be started so that the requested delivery date can be kept to.

The following data is taken into account
- route
- shipping point
- material
- ship-to party

The following times are taken into account:
- transit time from the shipping point to the customer location
- loading time
- pick/pack time
- transportation lead time

If backwards scheduling determines a date for starting one of the above activities to be in the past, forwards scheduling is initiated. Forwards scheduling determines the earliest possible date after the current date on which the shipping activities can begin. The date calculated is known as the material availability date. This date is used as the basis for scheduling the activities in the assembly order.

Scheduling in the Assembly Order
When you create a sales order with assembly processing, scheduling is automatically carried out. The purpose of scheduling is to find out whether it is possible to meet the requested delivery date entered by the user.

If the requested delivery date cannot be met, scheduling automatically determines the earliest date on which the sales order quantity can be confirmed (i.e. committed).

The Scheduling Process
Scheduling in assembly processing, i.e. delivery scheduling in the sales order and scheduling of the procurement element (production order, planned order or network) is always carried out in the same scheduling run: The user enters the requested delivery date and scheduling determines the confirmed date.

Internally, the scheduling run can be split into two parts:
1. Starting at the requested delivery date, the system first determines the basic finish date of the production order, planned order or network.
2. Starting at the basic finish date, the system then determines the committed date of the sales order.
Scheduling in Assembly Processing

Determining the Basic Finish Date

Starting at the requested delivery date, the system subtracts the delivery scheduling time, goods receipt processing time and in-house production time.

The next step depends on the in-house production time:

- If the start of the in-house production time **does not lie in the past** (case 1), the in-house production time finish is the basic finish date.

- If the start of the in-house production time **does lie in the past** (case 2), the system adds the in-house production time to today’s date in order to determine the basic finish date.

For assembly processing with production orders, the start of the in-house production time is taken as the explosion date for copying the bill of material and selecting a routing.

1) Determining the basic finish date

![Diagram](image)

Determining the Committed Date

The system now starts at the basic finish date (see case 1 or 2) and schedules the order or network backwards to determine the basic start date.

The next step depends on the basic start date:

- If the basic start date **does not lie in the past** (case 3), the system adds the goods receipt processing time and the delivery scheduling time to the basic finish date. The result is the committed date of the sales order.

- If the basic start date **does lie in the past** (case 4), the system takes today’s date as the new basic start date.
  - In *production orders* and *networks* the system carries out “today” scheduling to determine a new basic finish date. It then adds the goods receipt processing time...
and delivery scheduling time in order to determine the committed date of the sales order.

- **Planned orders** use the original basic finish date. The goods receipt processing time and the delivery scheduling time is then added in order to determine the committed date of the sales order.

2) Determining the committed date

![Diagram showing the process of determining the committed date in Assembly-to-order (LO-ASM)]
Availability Check in Assembly Processing

When creating the sales order, the system automatically carries out an availability check for the components needed for production and it also creates the assembly order in the background.

On completion of the availability check, the system either displays the availability control screen or, if parts are not available, it displays a list of the missing parts.

You can carry out the availability check as a check according to ATP logic or as a check against the planned independent requirements.

Please refer to the following sections for more detailed information:

- Availability Check According to ATP Logic [Page 43]
- Availability Check Against Planned Independent Requirements [Page 49]
- Missing Parts List (Availability Check: Overview) [Page 44]
- Missing Parts Overview [Page 47]
Availability Check According to ATP Logic

In the check according to ATP logic, the system checks whether the dependent requirements of each component are covered by specific receipt and issue elements or by stock. This check is carried out dynamically, that is, each time you carry out the check, the system recalculates the current situation. If a quantity can be committed for the requirement date, the system enters precisely this quantity as the committed quantity in the dependent requirements and the ATP quantity for the components is reduced by the committed quantity. Therefore, in the next availability check, dependent requirements can only be committed for the amount of the remaining ATP quantity.

The results of the check are displayed as follows:

- as a missing parts list for the planned order (Availability check: Overview)
- as either a missing parts list or a missing parts overview for the production order

For more information, please refer to the following sections:

- Missing Parts List (Availability Check: Overview) [Page 44]
- Missing Parts Overview [Page 47]

Settings for the Availability Check According to ATP Logic

The following settings must be maintained for this type of check:

- **checking group**
  
  In the material master, you must assign a checking group to the materials which are to be checked (MRP screen / sales data screen, field, Availability check).

- **checking rule**
  
  Checking rules are saved in Customizing for MRP or Production Control.

The system determines the scope of the availability check (that is, the receipts, issues and stocks that are to be included in the availability check) depending on the combination of the checking group and the checking rule. The checking rule and group also define further criteria for controlling the check according to ATP logic.

For the component check in assembly processing, the system determines the scope of the availability check using:

- the checking group defined in the material master record of the component and
- the checking rule defined in Customizing for MRP for the plant or the checking rule defined in Customizing for Production Orders per order type/status.

💡

You can exclude certain components that you know are always available (such as screws) from the availability check according to ATP logic. To avoid these components from being included in the availability check, enter the indicator, no check in the field entitled Availability check in the material master record, in the MRP 2 screen or in the Sales screen.
Missing Parts List (Availability Check: Overview)

The missing parts list displays the header data for the check and the results per component.

## Results per Component

The components checked are categorized into three groups:

- available components
- missing parts
- components for which an error occurred in the availability check

In the missing parts list, the system only displays the missing parts and components for which an error occurred in the availability check.

The components are displayed according to a color code depending on the situation. You can check the significance of the colors by selecting View → Color legend. If you do not only want to see the missing parts and components for which an error occurred in the check but you require the complete list, select View → Check result → All components.

A number of fields (which you can change as necessary) are displayed per component, for example, material number, material short text, plant, storage location, requirements quantity, committed quantity and so on. You can change the selection of the fields to be displayed, that is, you can add or remove fields and you can also reorganize the sequence of the display.

The most important fields for the availability check are listed below:

- **requirements quantity**
  This is the dependent requirements quantity resulting from the explosion of the BOM.

- **requirements date**
  The requirements date is the date on which the components have to be available - this is usually the order start date of the planned order.

- **committed quantity**
  The committed quantity is the maximum quantity available on the requirements date according to the check of all components. It depends on the component with the smallest available quantity on the requirements date.

  On saving the result of the check, this quantity is copied to the planned order as the committed quantity.

- **committed date**
  This date is the earliest date on which - per component - the total requirement quantity is available. If a component is never fully available, the system enters 99.99.9999.

- **ATP quantity**
  The ATP quantity is the receipt quantity of component available on the requirements date. This quantity may be greater than the committed quantity as it is often the case that some components are completely available on the requirements date but others are only partially available.
Header Data for the Availability Check

In the header of the availability overview, the system displays the following general data:

- number of components included in the check
- number of missing parts
- total committed date (only calculated in the check according to ATP logic)
  
  This is the date on which the complete requirement quantity is available including the in-house production time of the header material. This date is copied to the planned order as the order committed date on saving the results of the availability check. The total committed date depends on the following:
  - If the quantity required can be completely confirmed for the requirement date, the total committed date corresponds to the order finish date of the planned order.
  - If the quantity required cannot be completely confirmed for the requirement date, as not every component can be available in sufficient quantity by this date, then the total committed date corresponds to the date of the last material to be completely available plus the in-house production time of the header material.
  - If one of the components is not available in sufficient quantity by the requirement date and if this component cannot be made completely available for any later date, then the system cannot calculate a total committed date.
- partial committed date/quantity (only calculated in the check according to ATP logic)
  
  The partial committed date is displayed along with the partial confirmation quantity when the components are not completely available by the requirement date, however, a partial quantity is available on a later date (before the total committed date). Thus, this partial committed date represents the next point in time when a partial delivery can be made. Dates and quantities are based on the component with the least partial available quantity.

Further Functions in the Missing Parts List

Availability check per component

For information purposes, you can check the detailed date proposals per component. To do this, select the appropriate component and then select, Edit → Check availability. Depending on the type of check carried out (ATP logic or check against planned independent requirements), you receive the following data:

Check according to ATP logic

The system displays the dialog box entitled, Date Proposals with the individual committed dates and quantities.

In the dialog box, you can also check the scope of the availability check, that is, you can check which stocks, receipts and issues are to be included in the check.

Moreover, from this dialog box, you can branch to the period totals display (pushbutton, Period totals) and to the availability overview of the components (pushbutton, ATP display).

In the availability overview, the system displays the checked dependent requirements as simulative dependent requirements (SimReq) as they are not yet saved in the database.

Check against planned independent requirements
Missing Parts List (Availability Check: Overview)

The system displays the total requirements.

Here, the system displays the planned independent requirements as well as the dependent requirements that were assigned (that is, consumed) for the components selected. As the dependent requirements are not yet saved in the database, they are displayed as simulative dependent requirements (SimReq).

Selection of Other Fields for the Missing Parts List

1. To change the selection of the fields, select View → Choose fields.
   The system displays the dialog box entitled Chosen Fields: Sequence.
2. To add new fields to the display, select the pushbutton entitled Selection list...
   The system displays the dialog box entitled Selection List displaying all the fields available where you can select the appropriate fields.
3. To save the new selections, select Copy and close.

Deleting Fields in the Missing Parts List

1. To delete fields, select View → Choose fields.
   The system displays the dialog box entitled Chosen Fields: Sequence.
2. To select the fields you want to delete, double-click on these fields.
   The selected fields are then flagged to be deleted.
3. Now, press the pushbutton entitled, Delete.
   The highlighted fields are deleted from the list.
4. To confirm the deletion, select the field entitled, Copy.
   The fields deleted here are no longer displayed in the availability overview.
Missing Parts Overview

The missing parts overview displays the results of the availability check per component and the header data for the check. In the lower section of the screen, you can also see the total committed date and the number of missing parts.

Results per Component

In the missing parts overview, the system only displays the parts that are actually missing. The fields relevant to the availability check are described below:

- **requirements quantity**
  This is the dependent requirements quantity resulting from the explosion of the BOM.

- **requirements date**
  The requirements date is the date on which the components have to be available - this is usually the order start date of the planned order.

- **committed quantity**
  The committed quantity is the maximum quantity available on the requirements date according to the check of all components. It depends on the component with the smallest available quantity on the requirements date.

  On saving the result of the check, this quantity is copied to the planned order as the committed quantity.

- **committed date**
  This date is the earliest date on which - per component - the total requirement quantity is available. If a component is never fully available, the system enters 99.99.9999.

- **ATP quantity**
  The ATP quantity is the receipt quantity of component available on the requirements date. This quantity may be greater than the committed quantity as it is often the case that some components are completely available on the requirements date but others are only partially available.

Header Data for the Availability Check

In the header of the missing parts overview, the system displays the following general data:

- order type
- plant
- material number and short text

Total Committed Date/Display Missing Parts

In the lower section of the screen, the system displays the following data:

- number of missing parts
- total committed date (only calculated in the check according to ATP logic)
Missing Parts Overview

This is the date on which the complete requirement quantity is available including the in-house production time of the header material. This date is copied to the planned order as the order committed date on saving the results of the availability check. The total committed date depends on the following:

- If the quantity required can be completely confirmed for the requirement date, the total committed date corresponds to the order finish date of the planned order.

- If the quantity required cannot be completely confirmed for the requirement date, as not every component can be available in sufficient quantity by this date, then the total committed date corresponds to the date of the last material to be completely available plus the in-house production time of the header material.

- If one of the components is not available in sufficient quantity by the requirement date and if this component cannot be made completely available for any later date, then the system cannot calculate a total committed date. In this case, the system enters the figure, 99.99.9999 in the Total committed date field.
Availability Check Against Planned Independent Requirements

In the check against planned independent requirements, the system only checks the open planned independent requirement quantities created for the components. This means that the ATP quantity is not included in this availability check nor are receipts or stocks.

This type of availability check is most useful:
- if assembly planning or phantom assembly planning is used to plan the components
- if quick statements about the availability situation are required and the results from this check are precise enough

The system uses the open planned independent requirements quantity at component level to determine a committed quantity and this quantity is copied to the planned order header in the Committed quantity field. As opposed to the availability check according to ATP logic, however, the committed quantity is not recorded in the dependent requirements. The planned independent requirements of the components are not consumed by the committed quantity but by the complete dependent requirements quantity. In following availability checks, the system can only commit quantities for the amount of planned independent requirements that have not yet been consumed.

In the availability check against planned independent requirements, the following dates/quantities are not calculated:
- total committed date
- partial committed date/quantity

The results of the check are displayed as follows:
- as a missing parts list for the planned order (Availability Check: Overview)
- as missing parts list or missing parts overview for the production order

For more information, please refer to the following sections:

Missing Parts List (Availability Check: Overview) [Page 44]
Missing Parts Overview [Page 47]

Settings for the Availability Check Against Planned Independent Requirements

You must maintain the following settings for the check against planned independent requirements:

- checking group
  
  You must enter a checking group in the material master records (MRP screens / Sales data screens) of the assemblies/components for which the availability check against planned independent requirements is to be carried out. The system uses the checking group to control whether the check against planned independent requirements is allowed. The following options are available for setting the checking group:
  
  - No check against planned independent requirements
Availability Check Against Planned Independent Requirements

If this option has been selected for the checking group, no check against planned independent requirements can be carried out in the planned order for this component. However, the material can still be included in the availability check according to ATP logic.

- **Always check the material against planned independent requirements**

  If this option has been selected for the checking group, the availability check against planned independent requirements can always be carried out in the planned order for this component. At the same time, it is also possible to carry out the availability check according to ATP logic for this material.

- **Only check the material against planned independent requirements if the material is a phantom assembly**

  If this option has been selected for the checking group, the system can only carry out the check against planned independent requirements when dealing with phantom assemblies (special procurement key, Phantom assembly).

These settings for the checking groups are made in Customizing for Sales/Distribution (step entitled, Define checking groups), in the field entitled, Relevancy.

In the availability check against planned independent requirements, the checking group does **not** control the scope of the check as it is only carried out against planned independent requirements.

- **consumption mode/consumption period**

  The following indicators must be maintained in the material master record to determine the period in which planned independent requirements are allowed to be consumed by dependent requirements.

  - Consumption mode, that is, the direction of the consumption. You can determine whether planned independent requirements can be consumed in the past and/or in the future.

  - Consumption period, that is, the length of the period (either in the past or in the future) during which planned independent requirements are allowed to be consumed.

- **requirements class**

  If the availability check against planned independent requirements is accessed in assembly processing, the indicator *Type of component check (TCC)* must have been given the value ‘1’ (check against planned independent requirements) in the requirements class assigned to the corresponding planning strategy. For more information, see also **Settings for Assembly Processing** [Page 18].
Navigating in the Sales Order in Assembly Processing

In assembly processing, you can access the assembly order when either creating or changing the sales order.

If you are dealing with a procedure with a static assembly type, proceed as follows:

1. On the sales order overview screen, select Item → Schedule lines → Quantities/dates.
2. On the schedule line screen, select Edit → Procurement.
   The system branches to the procurement screen where the number of the assembly order created is displayed. Depending on the type of assembly processing, you can branch to various screens which provide you with more detailed information on, for example, components, deadlines, and operations.

If you are dealing with a procedure with a dynamic assembly type, proceed as follows:

1. On the overview screen, select Environment → Availability.
   The system displays the dialog box entitled, Reqmts/Stocks Indiv. Customer Segment.
2. Position the cursor on the procurement element and press the Choose button.
   The system branches to the procurement elements.
How Changes Affect Assembly Processing

Changes in the Sales Order

Any changes in customer requirements which are made in the sales order take effect in dependent assembly orders until:

- an operation has the status either PCNF (partially confirmed) or CNF (fully confirmed)
- the order header has the status DLT (deleted), LKD (locked), or TECO (technically completed)
- the components have been issued from stock

When you make changes to a sales order to which a production order is attached, the system checks the status of the production order. Changes are only passed on before the production order is released. In the case of the planned order and the network, no such check is made.

Changes in the Assembly Order

Any changes made to dates and quantities in the dependent assembly order are updated in the sales order automatically unless the fixed quantity and date indicator has been set for the item.

Any changes to costs in the dependent assembly order are updated in the sales order. However, if required, you can also switch off this link between the assembly order and the sales order. To do this, select the indicator No update in the appropriate requirements class. If you have selected this indicator, any changes to the assembly order are not passed on to the sales order. For more information on this topic, please refer to the section entitled Settings for Assembly Processing [Page 18].

Changes to Master Data

Any changes which are made to the master data after you have created the assembly order are not updated automatically in the sales order or the assembly order. If the changes are relevant for the sales order and assembly order, you must update these documents manually.
Pricing in the Assembly Order

Unit costing is performed in the production order and the network. If you use the static assemble-to-order procedure, the unit cost estimate can be copied into the sales order item.

You control this in Customizing for Sales and Distribution → Basic Functions → Availability Check and Transfer of Requirements → Transfer of Requirements → Define Requirements Classes. If the unit cost estimate is to be copied into the sales order item, mark the PC column of the relevant requirements class.

The unit costing can only be copied correctly if there is only one assembly order for a particular item.

For more information on requirements, see About Requirements in Sales and Distribution Processing [Ext.].

There are two condition types in the standard pricing procedure which can be used to record the cost estimate in the sales order item. In Customizing for the sales order type, you define which of these condition types is to be used. The condition types are designed to be used as follows:

- **EK01** can be used as a basis for determining a price for the make-to-order item.
- **EK02** is a statistical condition which can used instead of VPRS to calculate the profit margin for the assembly item. The VPRS value is purely informative in this case.

You control this in Customizing for Sales and Distribution → Sales → Sales Documents → Sales Document Header → Define Sales Document Types. Choose the relevant sales order type and enter the necessary condition type in the CndType line items field in the Billing section.
Pricing in the Assembly Order

Unit costing is not performed in planned orders.

See also:

For information on pricing, see Pricing and Conditions [Ext.] in Sales and Distribution
Shipping in Assembly Processing

Shipping is performed in the usual way on the basis of delivery scheduling.

For information on shipping, see the SAP documentation *SD Sales and Distribution*, Section *Shipping*. 

Billing in Assembly Processing

You have several possibilities for billing in assembly processing:

- You can bill the entire amount in the usual way using the billing due list.
- You can bill partial amounts over a specified period using a milestone billing plan.
- You can perform billing based on actual costs using the resource-related billing function.

Resource-related Billing for Projects

When you create a project at the same time as the network from the sales order, you can bill the customer directly for costs in what is called resource-related billing.

The WBS element to which the account assignment is to be made must also be a billing element superior in the work breakdown structure to all cost-carrying objects related to the project.

You can ensure that you always have the top billing element in the project hierarchy by entering the superior WBS element (if it is different from the WBS element you defined for account assignment) in an assignment table. Select the menu options Logistics → Project Management → Planning and then → Resources → AsgnNewKey → WBS elmt.

For more information on assigning new WBS elements to materials, refer to the SAP documentation PP Material Requirements Planning.

See also:

For information on this, see the SAP documentation SD Sales and Distribution, Sections Billing, Resource-related Billing and Sales: Common Features in Sales Order Processing: Using Billing Plans.
Collecting Costs in Assembly Processing

The methods used for collecting costs in conventional make-to-order processing are also used in assembly processing. You have the following options:

- Assigning costs using the sales order
- Assigning costs using the projects system

See also:

For more detailed information on collecting costs, see the SAP documentation SD Sales and Distribution, Section, Sales: Working With Special Business Processes: Make-to-order Processing and CO Cost Object Controlling.
Sample Scenario: Assembly Processing Using a Production Order

MAT01 has been assigned strategy group 82. When a sales order is created for this material, a production order is created automatically in the background. The availability check is performed at component level. Scheduling determines whether the shipping activities and assembly activities can be performed so that the requested delivery date can be kept to. Taking into account the results of scheduling and the availability check, the system proposes the earliest possible delivery date on the basis of the component with the latest availability date. Requirements are passed on as sales order stock.

The manufacturing costs are calculated in the production order and are passed to the sales order. The costs are recorded in the condition type EK02 and are displayed on the pricing screen.

Shipping activities are performed in the usual way.

The assembly transaction can be invoiced using the usual forms of billing.

The assembly transaction is settled using one of the usual procedures for settling make-to-order transactions.
Make-to-Order Without Assembly Processing

If the make-to-order items are not to be assembled till a later point in time and, therefore, the availability situation at the time of order entry is not so critical, you can perform make-to-order without using assembly processing.

In this case, the availability check, delivery date determination and costing are all performed after order entry.

Using a Project Without Assembly Processing

If you do not need accurate information on material availability, schedules or costs at the time you create a sales order, you do not have to use assembly processing to use the Project System.

You can still assign a sales order, such as a sales order, when you create a network. The following applies:

- If you assign a network to a sales order that is settled to a project, you also maintain a WBS element in the network header at the same time. The WBS element must have the same project definition as the WBS element which you entered for account assignment in the sales order.
  
  In this case, the system automatically creates the settlement rules for the network.

- If you assign a sales order, that is not settled to a project, you cannot enter any WBS elements in the network header.

See also:

For more information on sales orders and how to assign sales orders to a WBS element, refer to the SAP documentation SD Sales and Distribution, Section Sales: Working with Special Business Processes: Make-to-order Processing.
Production Planning and Control for Assembly Processing

In this section, a description of production planning and control for each procurement element is provided.

Production Planning and Control for Production Orders [Page 61]
Production Planning and Control for Repetitive Manufacturing [Page 62]
Production Planning and Control for Networks and Projects [Page 65]
Production Planning and Control for Production Orders

Production planning and control for assembly processing and production orders does not differ from production planning and control for production orders without assembly processing.

For more information on production planning and control for production orders, please refer to the SAP documentation *PP Production Orders*. 
Production Planning and Control for Repetitive Manufacturing

In this section, a description is given of the special features for planning the assembly order in the planning table as well as posting the goods receipt for the assembly/planned order. If you require more information on production planning and control using repetitive manufacturing, please refer to the SAP documentation PP Repetitive Manufacturing.

If the material to be planned has been flagged for repetitive manufacturing and has been assigned a repetitive manufacturing profile in the material master record, you can carry out capacity planning and you can assign the assembly order to production lines in the planning table of repetitive manufacturing.

You can also carry out capacity planning for the assembly/planned order from the main menu of capacity planning or from the current stock/requirements list. For more information on capacity planning, please refer to the SAP documentation PP Capacity Planning.

You post the goods receipt for the assembly/planned order using a special function in the main menu of repetitive manufacturing.

Processing Assembly Orders in the Planning Table From the Material View

Make-to-order production is used for assembly orders and stock is managed individually for each sales order. Therefore, the following functions are not available for planning production quantities over several periods:

- assigning production quantities from several periods to the production lines in one step
- copying or smoothing requirement quantities
- increasing or reducing quantities from several periods in one step
- rolling forward planned quantities that have not yet been backflushed

It is also not possible to carry out a distribution according to a daily rate as new planned orders are created for each day in this function. This does not make sense for assembly processing.

You can only process one assembly order at a time.

To process the assembly order in the planning table from material view, proceed as follows:

1. Starting from the main menu of repetitive manufacturing, select RS quantities → Create and change.
   The system branches to the initial screen of the planning table.
2. Enter the plant, select the material view, and press Choose.
   The system displays the dialog box entitled, Selection Data.
3. Enter the material number and the period of examination.

Changing Dates or Quantities in Assembly Orders

To change either the quantity or a date in an assembly order, proceed as follows:

Double-click the mouse on the corresponding period.
Assigning Assembly Orders to Production Lines

Assembly orders can only be assigned to the production line one at a time. To do this, proceed as follows:

1. Position the cursor on the assembly order.
2. Select Edit → Assign quantities → For one period.
   The system displays the dialog box entitled, Detailed Data for Assignment.
3. Select the production version or the production line on which the product is to be produced.

Capacity Planning

Capacity planning is carried out as in repetitive manufacturing without make-to-order. For more information on this, please refer to the SAP documentation PP Repetitive Manufacturing.

GR Posting for the Assembly Order

To post the goods receipt for the assembly order, proceed as follows:

1. Starting from the menu screen of repetitive manufacturing, select Backflush → Final backflush.
   The backflushing screen appears.
2. Enter the following data here:
   Posting date
   The system proposes the current date as the posting date. It uses this date to determine the BOM of the assigned planned order. If no further planned order exists for the sales order, the system explodes the BOM that is valid on this date.
   Document date
   The system proposes the current date as the document date. Check this date.
   Plant
   Enter the plant for which you want to carry out the goods receipt for the sales order.
   Sales order
   The system uses the sales order to determine the planned orders.

   If only one planned order is assigned, it is automatically proposed in the appropriate field by the system once you have selected Enter. The system also proposes the planned order quantity in the Backflush quantity field.

   If several planned orders exist for the sales order, then the system displays a dialog box once you have selected Enter. Here, you must select the planned order for which you
want to carry out the goods receipt. Then the system enters this planned order in the appropriate field and proposes the planned order quantity in the Backflush quantity field.

If no further planned orders exist for this sales order as the quantity has already been produced, but you still want to carry out a goods receipt (overdelivery), the system explodes the BOM that is valid for the current date.

**Sales order item**

If a sales order contains several materials, you must enter the sales order item as well as the sales order number. Then, the system proposes the material for which the goods receipt is to be posted automatically once you have selected Enter as well as the planned order quantity.

3. Now you have two options:
   - Save the data here.
   - Or, to avoid posting errors and to check component data, press Execute. You then branch into the component overview screen where you can make any necessary corrections or you can also carry out the availability check. Save your data.

4. In the background, the system explodes the BOM, posts the goods movements on the basis of the BOM explosion, reduces planned orders or run schedule quantities, and updates costs and statistics.

Backorder postings from backflushing are not possible here as the postings are not carried out on the basis of a run schedule header.
Production Planning and Control for Networks and Projects

Production planning and control for assembly processing and projects does not differ from production planning and control for projects without assembly processing.

For more information on production planning and control for projects, please refer to the SAP documentation *PS Project System*. 